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BB B2C
The online hyperlocal 

delivery app

BB Instant
IoT-enabled vending machines 

for product purchase

BB daily
Subscription service for daily 

delivery of essentials

BB B2B
Sales to MT/GT, institutions and 

HoReCa

Only Recommended for impulse 
purchase F&B categories at a 
INR30-40 price point. 

Eg: YogaBar Energy/Breakfast Bar –
OK NOT for large Muesli packs. 
NOT for Personal Care categories.

Pro-Tip: For brand discovery and 
awareness; not a major revenue 
contributor except for high 
frequency categories such as:

Milk, Fruits & Vegetables, Bread, 
Dairy & Eggs, Pooja Essentials 

Startup brands should not 
focus on B2B

0% 20% 40% 60% 80% 100%

BB revenue contribution by medium

Web-based App-based

BB Sales Channels
BB runs 4 different apps: We recommend focus on BB B2C app only

Focus only on App 
elements– 80% orders are 

from App

Contribution to overall sales

For details on sales channels, please refer annexures



Category L1
Top-level category

(TLC)

Primary category on the BB website/application
11 L1 categories ranging from Fruits and Vegetables, 
Beauty and Hygiene to Baby Care

Category L2
Mid-level category

(MLC)

Category L3
Low-level category

(LLC)

Secondary category on the BB website/application
Second degree categorization under each primary category
Example: Oral Care, Hair Care, Makeup, etc under Beauty and 

Hygiene L1 Category

Tertiary category on the BB website/application
Third degree categorization for specific product ranges
Example: Shampoos, Hair Color, Hair Oil

L1 L2 L3

As the categories appear on the website

Pro Tip: L2 Category, also called MLC or Mid-level Category is most relevant for competitive category study

BB terminology
Category & Product Hierarchy

11 Primary 
or TLC 
categories

Beauty & 
hygiene has 
9 MLC 
categories

Hair Care 
has 7 LLC 
categories



Mobile L1 View under category 
tile icon (TLC)

Bakery, Cakes and Dairy L1 
Category dropdown shows the 

list of L2s classified under it

Mobile L2 View for 
the Dairy Category 

(MLC)

Mobile L3 View under the 
Paneer, Tofu & Cream sub-

category (LLC)

BB terminology
Category & Product Hierarchy (L1>L2>L3): Mobile View



BB terminology
Shop-in-shop

BB terminology for whenever a list of products is displayed upon clicking on any asset on the platform.
Note: Product listings are called shop-in-shop on the BB platform

Shop-in-shop for Teas: Clicking on Teas over the Home 
Page leads to a page to shop for various SKUs of Tea

Not a shop-in-shop: Upon clicking on the banner, 
the app is redirected to the beauty store page



Longitudinal ad-elements with CTA to improve discoverability and conversions. Details of each element/banner covered in following slides.
*BB to introduce personalized banners to target specific audiences. 

Push Notifications Push notifications sent out to targeted audiences for offers and remarketing

Injection banner Banner element under specific categories

Sampling Free sampling to households to acquire new customers 

Digital marketing Social media campaigns over FB/ IG

Sponsored Products Three product listings under L3 category and search key-terms for increased SKU visibility 

Search Term banner Banner element under searches for specific keywords

Note: Ad-elements pricing chart here.

What are Banners?

An example of a banner advertisement

BB terminology
Universe of on-platform ad-elements for products discovery (Visibility Assets)

L1 Top Banner First slot that displays banner under any L1 category

Home Page Banner First slot that displays banner on the home page of the app/website

BB Accelerate Offers

Fireside Recommends

Category Page Banner

Offer Page Banner

First slot that displays banners under any TLC, MLC or LLC

Banners displayed under “Offers” tab

https://drive.google.com/file/d/1IHqH3Gfx5-kBnMKHDThizhbn6o2EoOIz/view?usp=sharing


1,2Pro Tip: 60% of BB sales are search-term led, not category-navigation led. Hence it is important to focus on STB and SP.

Search Page

Ranking 
and 
prompts 
based on 
sales in 
region

Sponsored Products (SP)1 Search Term Banner (STB)2

Search 
term 
banner

Sponsored 
product for 
search term 
”yoghurt” 

Visibility Assets
Priority ad-elements for startups



Push Notifications Shop-in-shop

Push notifications 
leading to a shop-
in-shop.

Alternatively PNs 
can also drive 
clicks to brand 
description pages 
for early entrants 
to showcase brand 
portfolio and 
offers

Out of Platform Inventory:
Unlike STB or SP, PNs are classified out-of-
platform inventory by the bb team internally

Push notifications are sent between 
7.30am-8.30am in the morning and 
6-8.30pm in the evening

Visibility Assets
Priority ad-elements for startups

Pro Tip: Push Notifications is the most effective BB element to engage targeted audiences



Injection Banner (IB)

Horlicks Injection 
banner while 
navigating the 
health, drink, 
supplement 
category

Visibility Assets
Priority ad-elements for startups 

Injection Banners: 
Category-navigation led inventory element that 
assists in brand discovery. 

Navigation-led sales contribute smaller ~40% 
of overall BB sales; can hence de-prioritize IB 
over SP, STB and PNs.

SIS for Horlicks IB

In-Platform Inventory:
STB, SP, IBs are classified in-platform inventory 
by the bb team internally

For priority-2 ad-elements, refer annexures.
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Fireside recommends brands to perform market deep dive study to understand:

Focus L3s

Competitive landscape

While the brand may list across all L3s, it must look at the overall L3 category market size and 
transactions of the sub-category

Competition mapping of the L3 sub-category helps understand the category size available to each 
brand playing in the sub-segment 

Pro Tip (Category sales) to (# of competitor brands) ratio should be >50,000 INR/month*. Prioritize 
Moderate competition>Significant competition categories for market entry

For every 2 brands present in a category, the 
category size should be atleast INR 1,10,000 
INR/month. 

<INR 1,10,000 INR/m implies very competitive
>=INR 1,10,000 INR/m implies less 
competitive

Category Market Analysis
Understanding category competitiveness

Category Size: INR 250,000 /month

Competitor 1 Competitor 2 Competitor 3 Competitor 4

Category Size: INR 250,000 /month

Competitor 1 Competitor 2 Competitor 3 Competitor 4

Competitor 5 Competitor 6 Competitor 7

Moderate Competition Significant Competition

*Enter L3 category sizes of atleast INR 10 Lakhs/month

Note: Recommended template for Preboarding Metrics MIS attached here.

https://drive.google.com/file/d/1XhLP_HJO_WLLVMndl1GxYhS79oVtWnRH/view?usp=sharing


Product Selection/Development

Understand product attributes best suited to platform basis competitive landscape, search query demand, and pricing: 

10 brands

1 brand In such instance, it maybe lesser competitive to
introduce a variant in the Rs. 200-300 price point with a
40gm. or similar packaging for the product.
Alternatively brands could contemplate a multipack
offering with BB to target the customers without
reiterating product design.

INR 100-200

INR 200-300

20gm

40gm Search queries 

Search queries 

↟

↟

Category Market Analysis
Interventions for significant competition categories (1/2)

• Search Analysis to determine the search-demand/queries for price points and pack sizes   

• Value Analysis to determine the number of price per gram of various brands in the category

• Weight Analysis to determine the top-selling pack sizes in the category

Eg. Combining some of the above analysis:

• Price Point Analysis to determine the price pyramid and price points of the top-selling SKUs in the category

Pro Tip: To avoid multiple pack sizes in a portfolio, BB offers virtual bundling of SKUS



Category Market Analysis
Interventions for significant competition categories (2/2)

• Multi Pack is bundling SKUs to sell at lower than individual 
price points

• Single Brand Combo Pack is cross-selling two SKUs of the 
same brand with similar proposition

• Multi Brand Combo Pack cross-selling two non-competitive 
company SKUs with mutual agreement

Pro Tip: Startup Brands may engage in cross-selling for products that see synergies 
among themselves; eg. MamaEarth Hair Mask with Kapiva Biotin Gummies for Hair & Skin 

or YogaBar Protein Bar with Kapiva Plant-based Protein

Devise bundling offers as alternative to new SKU introductions basis top-selling SKUs and search demand to achieve 
maximum traction. Brands can bundle products in one of the following ways:

Alternatives to New Product Development (NPD)



One-year program designed to assist brands to turbocharge their 
growth over the BB platform through:

SPOC
For each brand BB shall appoint a SPOC to assist the brand in 
listing, cataloguing, marketing, payments, among others

Express listing
BB processes to handhold brand on enlisting, execution and 
timely updates such as inventory management and OOS tracking

Visibility 
Home page ad-element: emerging brands section 

Handholding
Startup brands to receive monthly performance tracking

On-demand
Customer support through SPOC for real-time query resolution

Ad-elements
Every month, accelerate brands can use 3 of the 6 elements 
among PN, STB, IB, SP, social media campaigns, and sampling

BB Accelerate Program Basics (1/2)



Category Market Analysis

Real-time support 

BB assists brands in category market analysis: market deep-
dive, price point analysis, competitive landscaping (L2/L3) 
and product salience basis competition, search query 
demand, pricing. 

Brands can reach out to SPOC for express responses over mail/chat

Emerging Brands

About 3-4 folds down on the home page, bb hosts an 
emerging brand section which is refreshed every 2-3 months 
Provides additional discoverability for new accelerate brands

BB Accelerate Program Basics (2/2)



Intensity shows early focus geographies 

bb Presence

bb is present in 26 cities as indicated by the geographic 
map on the right. The dark to light color indicates the 
higher to lower priority of listing for startup brands over 
the BB DCs (warehouses).

Warehouse Listing 

Top DCs for emerging brands in the following order:

Phase-1: Bangalore, Delhi-Gurgaon, Mumbai
Phase-2: Hyderabad, Chennai, Pune
Phase-3: Calcutta, Noida, Ahmedabad
Phase-4: All cities on the map shaded grey

Tip: bb shares DC-level insights for contribution and out-of-
stock metrics to the accelerate brands 

Pro Tip: Phase-1 contributes 50% of BB sales, Phase-2 next 25%, Phase-3 
next 15%. Brands should focus on Phase1 and Phase 2 for first 12 months!

Inventory Management – Warehousing Listing Priority
Focus DCs: Geographic Footprint



Inventory Model: For successful SKUs in SOR Model (Brand sales >INR 30Lakhs/month)

Paid-up inventory model where BB buys company stock and pays per credit days. The unsold inventory is often liquidated 
back the vendor. Since inventory risk is borne by BB, early stage brands are not signed-up for the inventory model.

Inventory Management – Business Models on BB
SOR > Inventory > Distribution

SOR (Sales or Return) Model: BB Accelerate Brands

Goods are received from the vendor and every 15days; the payment for sold inventory is remitted. Unsold goods are 
sent back to the vendor. De-risked inventory allows BB to stock more units of different company brands. Accelerate 
Brands are signed-up for SOR-model. 

Steps: PO generated>Brands supply stock>Goods Received Note (GRN)>SKU reflects on app!

Distribution: For top 5000 SKUs on the platform
5K Model or Express Delivery

Only the top 5000 selling SKUs on platform are organically a part of the bb express delivery team for service within 2 
hours. New Dark stores (smaller DCs) are created across the city which are stocked with these 5000 SKUs from the 
mother DCs (larger warehouses for rest of the deliveries).
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Category Listing 
and Linking

Each brand SKU, upon listing at BB, is assigned to one primary category L3

Each SKU can however be associated with more than one relevant L3 category with no cap on 
the maximum number of linkages so long as the product positioning justifies the categories

An example of a good listing for Yogabar present across both “Muesli” as well as 
“Muesli & Rice Cakes” L3 categories but a poor representation of Kellogg’s which is 
not present in “Muesli & Rice Cakes” L3 category. This means Yogabar Muesli will 

get discovered in Gourmet & World Food but Kellogg’s will not.

Picture 1: Snacks & Branded Foods>
Breakfast Cereals>
Muesli

Picture 2: Gourmet & World Food> Cereals & Breakfast > Muesli & Rice Cakes

Category and Product Listing
Maximizing brand discovery

Order: L1 > L2 > L3



Protein SKUs:
Ritebite Bar (a competitor) is present in
Snacks and Branded Foods > Chocolates 
and Candies > Chocolates*

Muesli SKUs:
Soulfull (a competitor) is present in 
Snacks and Branded Foods > Ready 
to Cook & Eat > Breakfast & Snack 
Mixes*

Muesli SKUs:
Nutty Yogi (a competitor) is present 
in Gourmet & World Food > Cereals & 
Breakfast > Gourmet Flakes*

Muesli SKUs:
Yogabar is present in Imported Oats 
under the Gourmet Food L1 but not 
in Snacks and Branded Foods > 
Breakfast Cereals > Oats & Porridge*

Category and Product Listing
Example: Missed Listing Opportunities for Yogabar



Order: L1 > L2 > L3

Fireside Recommendation
Muesli SKUs:
Snacks and Branded Foods > Breakfast Cereals > Kids Cereal
Snacks and Branded Foods > Breakfast Cereals > Muesli
Gourmet & World Food > Cereals & Breakfast > Imported Oats & Porridge
Gourmet & World Food > Cereals & Breakfast > Muesli & Rice Cakes
Snacks and Branded Foods > Breakfast Cereals > Oats & Porridge*
Snacks and Branded Foods > Ready to Cook & Eat > Breakfast & Snack Mixes*
Gourmet & World Food > Cereals & Breakfast > Gourmet Flakes*

Protein SKUs:
Snacks and Branded Foods > Breakfast Cereals > Granola & Cereal Bars
Gourmet & World Food > Snacks, Dry Fruits, Nuts > Healthy, Baked Snacks
Gourmet & World Food > Cereals & Breakfast > Cereal & Granola Bars
Snacks and Branded Foods > Chocolates and Candies > Chocolates*

*All the L3 categories that YogaBar can potentially list in

Present Listing
Muesli SKUs:
Snacks and Branded Foods > Breakfast Cereals > Kids Cereal
Snacks and Branded Foods > Breakfast Cereals > Muesli
Gourmet & World Food > Cereals & Breakfast > Imported Oats & Porridge
Gourmet & World Food > Cereals & Breakfast > Muesli & Rice Cakes

Protein SKUs:
Snacks and Branded Foods > Breakfast Cereals > Granola & Cereal Bars
Gourmet & World Food > Snacks, Dry Fruits, Nuts > Healthy, Baked Snacks
Gourmet & World Food > Cereals & Breakfast > Cereal & Granola Bars

Category and Product Listing
Example: Recommended Listing for Yogabar

ProTip: Look at all categories and sub-categories before listing to maximize brand discoverability and sales



How to track listing?
Brands can track their listing on 
the brand page (website)

Eg. All the L3 listings for Yogabar
are given on the brand page

Category and Product Listing
Tracking your listings 



Product listing pages contains product images alongside several attributes of the product 
ranging from pack sizes, how-to-use, ingredients, reviews & ratings, and other info. 

It is essential to get three elements right on a product listing page:
1. Page Content
2. Product Images
3. Tag Values and Groups

Product Listing 
Pages (PLP)

Page Content The listing page must 
contain:

• Multi Pack Offers
• Pack Size Variants
• About
• Ingredients
• How to Use
• Product Code/Info

Category and Product Listing
Optimizing conversions through comprehensive product listing pages

Yogabar: Good listing page 
with all features of a PLP 
covered

Snickers: Poor listing page with 
ingredients and how to use of a PLP 
missing

Pack Size Variants Listed

ProTip: Include maximum category search terms in product 
description for better search-led discoverability



Product Images Product Listing Pages must contain the following images:

Category and Product Listing
Best practices for product image catalogue 

Poor Catalogue: 
Only 1 FOP shot. 

While the company 
has done a good 
job with content 

but poor on 
product images.

Good Catalogue: 
FOP Shot, Usage, Benefits, 
Feeding Guide. Could also 

include ingredients and BOP.

Poor Image Catalogue Good Image Catalogue

• Features and Benefits
• Offers/ tie-ups/ partnerships/ contests
• Nutritional Value close-up shot
• Usage Guide, if necessary

• Front of pack (FOP)
• Back of pack (BOP)
• Usage Shot (esp. for personal care)
• Ingredients close-up shot/ Product Hero shot

FOP

Features and 
Benefits

Product Hero

Usage Guide

Bundle Offer

BB product listing page: image guidelines.

https://drive.google.com/file/d/1JZppAUEokFhnRDsPbw6g1aYO7DlJvoQJ/view?usp=sharing


Category and Product Listing
Studying the image catalogues of two bars – Snickers and Yogabar – lots of elements missing

Snickers Images:

Yogabar Images:

Image Quality

Offers Image

FOP & BOP

Readability

Nutritional facts

Image Quality

Readability

FOP & BOP

Ingredients shot

Nutritional facts

Ingredients shot

Usage shot

Usage shot

Features and Benefits

Features and Benefits



Pro Tip: Since search-led sales constitute a majority at BB, it is critical to have your SKUs mapped to maximum relevant tag 
values to enhance brand discoverability

Tag Values and 
Tag Groups

The Master List for all tag groups and values can be found here.

Each SKU of a brand is mapped against an internal database of tag values that describe a 
product. A set of relevant tag values are grouped as a tag group.

There exists no cap on the maximum tag values that a brand SKU can be associated with.

How does tag value 
help?

Tag values are present in filters/ sort lists that consumers use to reach their choice of product

Missed tag value 
mappings

If a brand fails to map itself to tag values, 
it will not throw up in the filtered & search results

Category and Product Listing
What are tag values and groups and why are they important?

Tag values vs Tag 
groups

Tag group is the primary headers under which 
tag values can be selected for filtering search 
results; hence focus on tag values

https://drive.google.com/file/d/1Wr3fEmiqDJBjVF0oElUUu3orbStRjGJe/view?usp=sharing


Excellent tagging: User searches for ”Energy Bar” (OnTheRun does not appear in top search results) and Filters to Products with “No 
Added Sugar”: Finds only OnTheRun products (exception of Yogabar which is a SP ad-element)

Category and Product Listing
Tag Groups and Values: Case Study of ‘On The Run’ Bar (Good Tagging)



Category and Product Listing
Tag Groups and Values: Case Study of MamaEarth (Poor Tagging)

Poor tagging: User searches for ”Hair” and Filters to Products that are “Paraben Free": Finds 39 products across 4 page swipes but 
MamaEarth (brand position is toxin-free) products not found!

1st page swipe 2nd page swipe 3rd page swipe



Fireside Recommendation
Baby SKUs:
Country of Origin > India
Gender > Unisex
PackSize > 40ml 
PackSize > 50g 
PackSize > 75g (Pack of 2)
PackSize > 200ml (if any other missing)
Price > Rs. 101-200
Price > Rs. 201-500
Finish > Natural*
Formulation Type > Liquid/Gel/Cream/Lotion/Oil*
Oil Type > Olive/Sesame/Jojoba/Almond*

Formulation Type > Liquid yields Baby Dove and Mom & 
World products but no MamaEarth since no tagging

Present Tag Values
Baby SKUs:
Country of Origin > India
Gender > Unisex
PackSize > 40ml 
PackSize > 50g 
PackSize > 75g (Pack of 2)
PackSize > 200ml
Price > Rs. 101-200
Price > Rs. 201-500

Category and Product Listing
Potential Tagging Opportunities for MamaEarth

Finish > Natural or Skin Type > Sensitive Skin yields all 
The Moms Co products but no MamaEarth SKUs

Product Feature > Alcohol Free*
Product Feature > Anti-Bacterial/Herbal*
Product Feature > Toxin Safe*
Skin Type > Normal Skin/Combination Skin*
Skin Type > Sensitive Skin*
Shelf Life > 90+ days*
Recommended Age > 4-6 Months/…/24+ Months*
Product Format > Bottle/Bottle Pump/Baby Kit/Liquid*

*All potential tags that MamaEarth Baby SKUs could use

Concern > Daily Use*
Concern > Children*
Concern > SkinCare*
Concern > Soothing*
Hair Type > Normal/Fine/All*
Preference > Paraben-free*
Preference > PABA-free*
Preference > Cruelty-free*
Preference > Sulfate-free*
Preference > Phthalate-free*
Preference > Natural*

Preference > Dermatologically Tested*
Preference > Synthetic Color Free*
Preference > Paraffin Free*
Shampoo & Conditioner > Shampoo/Con*
Intensity > Mild*
Benefits > Natural/Herbal*
Benefits > Kids/ Children*
BodyCare > Body Lotion & Cream*
FaceCare > Face & Body*
HairCare > Baby oil & Shampoo*
Hair Oil & Serum > Hair Oil*

Each SKU may have more 
specific and relevant tag 

values that may be found in 
the tag values master sheet 

attached here.

https://drive.google.com/file/d/1Wr3fEmiqDJBjVF0oElUUu3orbStRjGJe/view?usp=sharing


Month-wise metrics tracking

Monthly tracking of the output of promotions, 
new ranges, and elements:

>Household sales and repeats
>Opportunity loss by DC
>Impressions and CTRs
>Cohort analysis

Note: Recommended template for MIS attached here.

Monthly Metrics Tracking

Quarter-wise comparison metrics

Quarterly tracking the comparison metrics 
against L2/L3 categories:

>Brand vs category growth
>Impressions and CTR comparison with 
category-best for the quarter
>Loss tracking of sales to other brands

Vendor management dashboard

SKU-level sales and other operational metrics 
can be tracked from the vendor management 
dashboard

Monthly Metrics Sheet

https://drive.google.com/file/d/1XhLP_HJO_WLLVMndl1GxYhS79oVtWnRH/view?usp=sharing


Benchmarks to peg against

Monthly Metrics Tracking
Performance benchmarks

*Assuming category growth 0.5% m-o-m since launch and 3.5% since 
accelerate while the avg. L3 competition was ~20 brands at launch 
and ~30 brands at accelerate signup

Quarterly Metrics Sheet

Note: Recommended template for MIS attached here.

Month-1 Month-3

Sales to 
L3

Orders to 
L3

Sales to 
L3

Orders to 
L3

All Brands 
since launch

0.18% 0.08% 0.43% 0.18%

Accelerate 
Brands since 

sign-up
0.29% 0.25% 0.69% 0.56%

https://drive.google.com/file/d/1XhLP_HJO_WLLVMndl1GxYhS79oVtWnRH/view?usp=sharing


Campaign 

Basics

Ad Type
Targeting 

Variables

Creative 

Variables

Types of ad-inventory 
available on BB platform for 

customer engagement 

Specific attributes to target 
different audiences basis 
customer action on the 

platform

Element-level strategies to 
optimize maximize CTR and 

engagement

CTR & ATC is driven by Ad Type, Targeting & Creative Variables. Need to optimize all 3 for best results:

Visibility Elements: Best Practices

• Search Term Banner*

• Sponsored Products*

• Push Notifications*

• Injection Banner*

• Behavior-based**

• Location-based

• Membership-based

• Image : text ratio

• Product features

• Ingredient story

• Offer type

*Priority elements **Most important element



Website

BB App

BB Accelerate

STB has a strong breadth of presence: A tea banner may well be placed in a 
snacking search category

Eg: Protein Bar for Ghee search- Bad 
cross usage example- no relevance

Search-Term Banner (STB)
Ad-Type (1/7)

• Use up to 10-12 keywords basis relevance from among popular 
search term queries for target audience to maximize conversions

• Use a couple of keywords from related sub-categories (basis 
consumer’s past purchase patterns) to maximize product 
discoverability. Eg. If 70% of past consumer baskets show that 
Yogabar has been purchased alongside Green Tea; “Green Tea” 
should be an associated search keyword

Do’s

Don’ts

• Do not use keywords for irrelevant categories – leads to 
unnecessary clicks with NO SALES! 
Eg. Yogurt for Baby Diapers Brand

Eg: Honey Banner on Yogurt search-
Good cross usage example

Row-long ad-element (banner) interlaced with search results that are 
thrown up with keyword/ brand searches

Search Term 
Banner

Search Term Banner most important since 60% BB sales are search-led

ProTip: Liaise with SPOC to identify top search keywords that drive purchases in your target segment



Website*

BB App

BB Accelerate

Sponsored Products (SP)
Ad-Type (2/7)

• Only 2-3 extremely relevant keywords allowed for targeting; BB provides top keywords for a category L3.

• Competitor names can be used as search keywords too! This is on 1st come 1st serve basis! Reserve your category 
leader search terms in advance. 

• In case of overbidding for same search term, the 1st brand -> 1st slot & 2nd brand -> 4th slot

Search Listing

Category Listing

• For the promoted SKU’s primary L3 category – try to get the 1st, 4th or 7th slot for SP. Otherwise, choose a secondary 
L3 category for the same SKU where the 1st slot is available basis higher search volumes

• OR choose a different SKU with higher search queries in the primary or secondary L3 categories where slots are 
available

Eg: Good Example of 
Competitor name 

bidding where “Amul” 
shows Nestle product

Sponsored 
Products (SP)

Sponsored Products 2nd most important search-term ad-inventory

*BB offers featured products for website 
at a separate cost: Not recommended 
since web-traffic is only 20% sales

Notes • The sponsored elements are ranked top for the entire month
• For accelerate brands, this counts as one element, however post the program the pricing is set at INR 3-8L/month

ProTip: For SP element, you can have one SKU mapped to 3 search listings and 1 
category listing OR multiple SKUs for each of the search listings and category listing

SP has 2 ad-elements: Search-listing and Category-listing

1st, 4th and 7th product slots under any search/ category result point to the 
brand using sponsored element

ProTip: Reserve your Bid for category leader keyword for the 1st 3-6 months of brand launch on BB!



Sponsored Products (SP)
Ad-Type (3/7): Sponsored Products: Example

Kapiva: Single SKU Promotion (for 1 element use- SP) Fresho: Multiple SKU Promotion (for 1 element use – SP) 

Search-Listing: 

Kapiva 1L Aloe Vera Juice 
with the search term “Juice”

Category-Listing: 

Kapiva 1L Aloe Vera Juice 
under Beverages > Fruit 
Juices & Drinks > Juices

Search-Listing: 

SKU1: Fresho Organic Skimmed 
Milk for Search term “Milk”

Search-Listing: 

SKU2: Fresho Organic Ghee 
with the search term “Ghee”



Sponsored Products (SP)
Ad-Type (4/7)

• Do remember to list yourself against both category and search terms for sponsored products 

• If all slots on the primary L3 are missed out, list on the secondary L3s basis maximum search volumes

• Place search bids on popular competitors’ names to maximize discoverability besides category keywords

Do’s

Don’ts

• Do not miss out on high-volume near keywords to display sponsored products

Eg: Poor search attribution where “yogurt” shows sponsored 
product but the search term “yoghurt” does not

Sponsored 
Products

Eg: Good search attribution where 
“Biscuit” and “Biscuits” both show 
sponsored products



Website

BB App

BB Accelerate
PNs are delivered to users between 7:30-8am and 6-8:30pm

Eg: Good example of using of the subject line and text field 
than to clutter the PN image

Push Notifications (PN)
Ad-Type (5/7): Only ad-element on platform for micro-targeting

• Use the PN header and subject line for detailed text instead of 
cluttering the PN image 

• Use different PN campaigns for different audiences: awareness, 
and remarketing

• Leverage the specific times of the day that PNs are delivered for 
specific ideas – such as Vahdam Tea ads over monsoon evenings

Do’s

Don’ts

• Do not use too much text in image creative

• Do not have a very small target group base for PN while specifying 
target attributes*

Creatives displayed over push notifications sent directly to the device lock 
screen/ notification center 

Push 
Notifications 

ProTip: Only ad-element on platform that has micro-segmentation based on consumer buying and browsing behavior. Can be used for both: Top-of-
Funnel (TOFU) awareness with rich images and Bottom-of-Funnel (BOFU, closing the sale) with customized text PNs (covered in next slide)

*minimum recommended audience size 1.25L users



All customers who added SKU X in the basket and later removed from the basket:
Hey Sakshi, you had shown interest in Lays; We have an exclusive offer for you. Add it back in your cart

All customers who visited the store X / PLP (L1 category page and lands on SIS or custom page)

PN for all customers having SKU X (potatoes here) present in the basket

Website

BB App Beta-testing

BB Accelerate Beta-testing

ProTip: Use especially for closing the sale (BOFU) & when bandwidth to develop new creatives is limited

Eg. 4. PNs (not shown here) for those 
customers who have added 'Cadbury 
dairy milk' in the saved for later list

Push Notifications (PN)
Ad-Type (6/7): PN 2.0 – Text-based PNs for BOFU/ closing the sale

Text-based (can also be creative-based) micro-targeted PNs to send out 
specialized texts w/ or w/o creatives real-time for audience engagement 
and better conversions

Specialized Text
Based PNs

Eg.1.

Eg.2.

Achieved CTR: 7.5%

Eg.3.

• Category browsed but abandoned
• Search abandoned
• Banner clicked abandoned
• PLP abandoned
• Product-in-cart
• Own-product abandoned cart
• Competitor-product abandoned cart

Targeting Variables



Website

BB App

BB Accelerate
Injection banners will be displayed only when shopper navigates to a specific 
L2 or L3 category 

Eg: Honey Banner under Beverages > 
Tea; Good cross usage example

Injection Banner (IB)
Ad-Type (7/7): <40% buying through category navigation. Use IB only after exhausting SP, STB and PNs. 

• Use injection banners across 3-4 relevant sub-categories to 
maximize brand awareness

• Create impressions and clicks using IB, and later use PNs to re-
target same audiences for closing the same

Do’s

Don’ts

• Do not use lesser browsed categories that see less consumer 
traction; always check with SPOC for category browsing footfalls

Eg: Injection banner for Nescafe 
coffee under Category > Beverages

Row-long ad-element interlaced with category listing displayed when 
browsing a category

Injection
Banner (IB)

ProTip: IBs are good for discovery not for sales. To be used in 
conjunction with PN for full-funnel solution.



Location-based

Behavior-based

Demography

Consumer purchase behavior based banners
Eg. Targeting all HHs who have added to cart 'Nachos & Chips’ or ‘Cold Drinks’, 
‘Snacks and namkeens’, in last 2 months but not bought Lays in last 3 months

Eg. Targeting all HHs who have purchased Pringles in the previous 3 months 
but have not bought it this month

Eg. Targeting all HHs who have bought "kids-cereal","children-2-5-yrs","kids-
5yrs","noodle-pasta-vermicelli","biscuits-cookies","cakes-pastries","chocolates-
candies" atleast once in last 3 months

Consumers based out of specific target geographies
Eg. Targeting all “All T1 cities” or specific Phase-1+2 city names such as 
“Bangalore, Delhi-Gurgaon, Mumbai, Hyderabad, Chennai, Pune”

Consideration

Remarketing

Membership-based Targeting consumers who are BB-star members
Eg. Targeting all HHs who are BB-star members and have purchased a “pet-
food”, ”Cat” item in the past month

*BB to soon offer search term + injection banners that would allow targeting variables

Targeting Variables
Can be used for Push Notifications & Social Media Only

• Category browsed but abandoned
• Search abandoned
• Banner clicked abandoned
• PLP abandoned

• Product-in-cart
• Own-product abandoned cart
• Competitor-product abandoned cart

Browsing



Creative Variables

Creative Variables PN + STB + IB Guidelines

Image: Text Ratio >50% space to be occupied by images

Image Type

100% pack shot; can further be augmented 
through usage shots 
Eg. Kid having Honey, or Dosa instead of Dosa
Batter, Roti with Ghee shot (Kapiva)

Communication Objective
Features and Benefits, Testimonials, Usage 
Occasions, Discounts

Offer type
Always include a number in the offer creative: 
could be amount-based or %age based

Offer timing Don’t mention offer period*

Celebrity endorsement Not necessary 

Contest/ Sweepstakes Not necessary 

Others Festive/Bulk offers
Discount Usage

Branding Product Benefit Ingredient story

Pack Shot Discount

*For internal use: typical offers are 25th to 24th of next month or till stocks last

Note: BB Banner Best Practices guide.

https://drive.google.com/file/d/1FTFTgmdHwNonfQueEOaGKY_xfnImIa9p/view?usp=sharing


In Summary: Full Funnel Solutions for BB
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Retargetting

TOFU MOFU BOFU Re-selling

Targeting Variables

Competitors search and 
browsed + Category 

Abandoned + Category 
ever bought

Behavior-based (TOFU 
interactions) + Cart & 

Page abandoned 
(Competition)

Behavior-based (MOFU 
interactions) + Cart 
abandoned & Page 
abandoned (Own)

Lapsers & repeating 
users

Ad-Type STB+SP+PN PN+IB*+STB* PN+IB*+STB*
Different PNs for lapsers 

and repeating

Creative Product Feature/ Benefit
Testimonials &

Customer Reviews
Offer

Lapsers: Offer
Repeaters: Cross-sell
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-
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*To be introduced on Bigbasket

Retargetting



Good Creative Poor Creative

Usage Discount

Benefit Product

Remarketing ad-creative for targeted audiences 
achieving above average CTRs through efficient use of 

creative elements

Some other reasons for poor creatives include choice of 
unappealing creative text or cluttered design

Illegible cursive 
font on phone

Too much text in 
the creative

Creative Performance Analysis – PNs
Some of the top and poor performing PNs

CTR: 4.68%

CTR: 0.36%

CTR: 0.29%



Human Shot

Brand

Benefit

Discount

Product Shot

One of the top performing banner creative that assembles elements of usage, benefit, brand, discount and product 
with a clear communication objective

Creative Performance Analysis – Banner 
Success factors behind a high performance banner

Good Creative

CTR: 3.17%
ATC: 25%



PNs *CTR

2.7%

2.0%

STBs

Creative Performance Analysis
Benchmark CTRs for top performing ad types

Average

Median

*Benchmark rates for injection banners and sponsored products (only been a month since launch) to be updated

1.02% 10.1%

1.37% 5.1%

Average

Median

CTR 
Rate

ATC 
Rate

ProTip: BB promises 50K-1L impressions/month for Accelerate Brands



Whenever you have such big sale days, brands get additional discoverability with even one SKU listed at a deep-discount offer. 
Reaching out to 1M customers for the SKU. (10M registered customers) –PNs/emails/banners/SIS etc. big awareness every quarter. High reach.

Participation in Category Activations and Big Sale Days
Eg. Participation on BB Big Sale: F47 (Freedom) Sale



Web App BB 
AccelerateSocial Media 

Campaigns
Creatives run across social media channels such as FB and IG. 

• Micro-targeted ads using BB purchase and browsing (cookie) 
data – high effectiveness

Carousal Image

Single Image

Benchmark Rates

Creative Type Avg. CPM Avg. CTR Avg. CPC Avg. ATC

Carousal 101.73 0.98 12.03 13%

• Carousels are a set of more than 1 images that may include 
different product shots, different SKUs, or narrate a brand story

Creative Type Avg. CPM Avg. CTR Avg. CPC Avg. ATC

Single Image 110.10 0.83 13.80 6%

Benchmark Rates

• Single Images over FB and Instagram maybe visualized as banner 
equivalent of BB on social media platform to convey offers on the 
brand products or to improve brand discovery

Social Media Campaigns



Videos • Videos are another form of social media inventory offered by 
bigbasket over both FB and Instagram 

GIFs

Benchmark Rates

• GIFs are a type of montage wherein a set of more than 1 images 
may be played in a timed format such as a video to include 
different pack shots, offers, or product usage scenarios

Creative 
Type

Avg. CPM Avg. CTR Avg. CPC
Avg. Cost per 

3sec Video
Avg. Cost per 
10sec Video

Avg. 
ATC

Video / Gif 135.63 0.78 17.64 1.48 3.97 9%

Pro Tip: Ensure the creative team shares all four creatives, and tracks 
progress against the benchmark rates to track creative performance

Analysis • The performance of a singular type of social media campaign 
wanes over weeks

• BB allows brands to share all 4 creatives to mutually decide the 
time and targeting of each of these to BB users on FB/IG

• Only 30% brands share all 4 creatives, next 20% share two and 
likely carousel & single image, rest 50% brands only one creative

Social Media Campaigns



Good Creatives Poor Creative

Some of the top performing social media creatives with 
major communication through images, usage and 

ingredient story

Product
Ingredients

Ingredient 
story

UsageProduct

Poor communication on 
what is the product

Video text-heavy with 
unclear communication

Some other key reasons for failed creatives include 
failing to call out offers, low audience reach, or limited 

product information

Social Media Campaigns
Some of the top and poor performing social campaigns

CTR: 2.1% CTR: 1.6% CTR: 0.55% CTR: 0.43%



Recommended Marketing Calendar

M3 M6M1

M12

Personal 
Care

Food & 
Beverage

Push Notification

Search Term Banner

Push Notification

Search Term Banner

Sponsored Products

Push Notification

Search Term Banner

Sponsored Products

Push Notification

Search Term Banner

Sponsored Products

Injection Banners

Social Campaigns

Sponsored Products

Social Campaigns

Push Notification

Search Term Banner

Sponsored Products

Sampling

Push Notification

Search Term Banner

Sponsored Products

Injection Banners

Social Campaigns

Full Funnel Solutions

Category Activations & 
Big Sale Days

Category Activations & 
Big Sale Days

Category Activations & 
Big Sale Days

Category Activations & 
Big Sale Days



Big Basket Playbook

Brand Take-Off

Comparative benchmarking

Range Rationalization

Who am I losing to?

Accelerate Extension



Comparative Benchmarking

Brand Sales = (# of HHs) * (Sales per HH)

Diagnostic Matrix

Our Brand Key Competition Category

Penetration # of new HHs over last quarter # of new HHs over last quarter # of HHs (Universe)

Repeat # of repeating HHs over last 2 quarters # of repeating HHs over last 2 quarters # of HHs (Universe)

AOV – New $ spend of new HHs per basket $ spend of new HHs per basket AOVs per basket

AOV – Repeat $ spend of repeat HHs per basket $ spend of repeat HHs per basket AOVs per basket

Lapsers
# of HHs lapsed over last 2 quarters, 

who are they going to?
# of HHs lapsed over last 2 quarters, 

who are they going to?

New HHs Repeat HHs



Category 
performance

Growth of category vs Growth of brand

Understand reasons behind slower growth due to:
a) emergence of more competitive brands, 
b) stock-outs (OOS)
c) poor on platform marketing performance 
d) poor product reviews (repeats) vs competitive brands

Revisit strategy for the quarter to sustain growth in coming quarters; Identify TG that is 
switching to our brand and target more of the same

Penetration of brand to the category

Recognize the reasons for poor performance ranging from poor pricing, competitive offers, 
poor creatives or poor product reviews/ feedback on the product

Increase product range for the well-performing sub-categories to sustain growth

Creative 
performance

Peer benchmarks

Benchmarks on Impressions and CTRs for peers in L2 and L3 categories across both emerging and 
incumbent brands

Best creative

Engage with BB Accelerate SPOC to share details on the best performing creatives for the category

Accelerate brands should engage in BB cross-brand comparison exercise to benchmark on quarterly basis against both L2 and L3 categories

Comparative Benchmarking



In the first 6 months, brands should be able to discover their core product offerings or hero products. These 
flagships should be marketed at scale while testing for other new variants per NPD pipeline.

• Discontinue poor performing products
• Develop NPD pipeline to keep refreshing product range and discovering new hero products

SKU 
performance

Performance of SKUs

Brands to benchmark SKU-level performance on parameters such as:
• SKU contribution to overall brand sales
• Growth of SKU sales per month (m-o-m growth)
• OOS-data for SKU performance

Competitor SKU performance

Besides benchmarking internally to find the low contributors, brands must tally this against market 
performance for the similar category to distinguish between discontinuing products or reiterating them

Hero products

Range Rationalization



For Kapiva, capsules (supplements) that performed well on Amazon, didn’t take off on BigBasket – 6months 
stock still lying – discounting for liquidation didn’t work either.

Factors to look while deciding SKU deactivation from platform:
• Contribution of SKU to brand revenue (offtake) 
• # of months of stock >3 months 
• # of months of stock >3 months after discounting
• SKU expiry (for FMCG) vs inventory serviceability

Analysis
Kapiva performed an 8 month analysis for 3-month cohorts. 
The analysis showed that only 1 product was moving in 3 months and the team had an overall 40 months stock. 
Even at a discounted rate; only 10-15 pieces per month were sold. Thus, the team left 4 months of inventory 
and took back rest for sale on Amazon.

SKU 
deactivation

Range Rationalization
SKU Deactivation: Kapiva Case-Study

BB replenishment team guidelines to deactivate a SKU? 
• If the SKU has a low or zero sales in the past one month with >75% availability
• If there is a consistent fill rate issue from vendor
• If a SKU is not serviced for a 3 months
• If the base qty. is way higher than the actual sales

Case Study

ProTip: MBQs generated by BB algorithm should be double-checked with inventory data, especially for 
first three months when MBQs are manually-fed



Loss 
Attribution

Loss Attribution Study

Brands >6 months on the BB platform should engage in a Loss Attribution Study to understand the competitor
brands to which they are losing consumers.

Sample cases of lost sales: 
• Brand issues push notification ------> customer looks at brand product variants -------> customer purchases a different product
• Push notification ------> customer likes product ------> customer adds to cart -----------> customer purchases a different product

Consumer Survey

BB-enabled engagement in consumer feedback surveys to recognize the reasons behind:
• why consumers switched/ began to use the brand
• using the brand - specifically the features consumers liked about the brand
• why consumers discontinued using the brand

Interventions

Interventions through PN, Social Media, New Product Introductions or Sampling other products in portfolio

Re-targeting lost consumers through PN targeting variables & offering discounts/ samples/ new products

• Journey 1: Customer purchases at 10% off -----> repeat purchaser
• Journey 2: Customer doesn’t purchase -----> Purchases on 30% off ------> Repeats on 20% off -----> repeat purchaser
• Journey 3: Customer lapsed from Protein Bars -----> Reasons through customer survey: Stopped Gymming -----> Retargeted with Muesli

Who am I losing to?
Interventions to lost sales

Note: BB charges a one-time INR10-15Lakhs for incumbents for the study. Brands to individually with BB SPOC for loss attribution study.

Corrective 
Interventions

Analyzing the reasons 
for lapse



Accelerate
Extension

BB accelerate program has an option to extend the program for another year on a case-based consideration

Brands that are ideally suited for extension range typically between INR 5 Lakhs to 20 Lakhs in sales per month

For instance, Kapiva, a FS portfolio brand has extended its Accelerate program for another year. 

Next Steps?



Month-wise Activity Checklist



S# M1 M2 M3 Q2 Q3 Q4

Plan Liaise with SPOC Liaise with SPOC Liaise with SPOC Liaise with SPOC Liaise with SPOC Liaise with SPOC

Get BB category 
understanding

Plan new product 
range

Realign marketing 
calendar

Plan new product 
range

Realign marketing 
calendar

Plan DC listing: City 
and assortment

Plan OOS-wise WH 
listing

Range Rationalization

Optimize category listing 
and pdt listing (Slide 21-31)

Comparative 
benchmarking

Comparative 
benchmarking

Plan mktg calendar, 
align with bb mktg calendar

Execute Generate Central PO ID Introduce new 
products (list+tag)

Introduce new 
products (list+tag)

De-list 
underperforming SKUs

Activate full-funnel 
solutions (Slide 44)

Activate full-funnel 
solutions (Slide 44)

Activate full-funnel 
solutions (Slide 44)

Execute mktg calendar 
+ Build new creatives

Execute mktg calendar 
+ Build new creatives

Execute mktg calendar 
+ Build new creatives

Build new creatives
Category Activation/ 

Big Sale Day
Interventions basis 

”who am I losing to?”

Category Activation/ 
Big Sale Day

Analyze
Monthly MIS + Vendor 

Dashboard tracking for SKU 
data by DCs

Track MIS
Quarterly MIS + 

Advanced brand report

prepared by BB

Track MIS Track MIS

Campaign-impact 
analysis

Campaign-impact 
analysis

Campaign-impact 
analysis

Campaign-impact 
analysis

Campaign-impact 
analysis

Analyze monthly-fill 
rate

Analyze monthly-fill 
rate

Analyze monthly-fill 
rate

Analyze monthly-fill 
rate

Analyze monthly-fill 
rate

Ratings and reviews 
analysis

Who am I losing to? 
study

Ratings and reviews 
analysis

Month-wise Activity Checklist



Annexures



BigBasket Business Models

BB offers 4 major biz-models over its platform for the brands to explore:

• bb B2C
• bb daily
• bb instant
• bb B2B

Focus only on in-App Elements to being with for max impact. 

BigBasket B2C

BB revenue contribution by bizmodel

bb B2C bb daily bb instant bb B2B

0% 20% 40% 60% 80% 100%

BB revenue contribution by medium

Web-based App-based

BB Channels
Overview of other BB sales apps



IoT-enabled vending machines for product purchase through bb instant app

Opportunity
While bb instant contributes 1% of overall bb sales, it may improve discoverability
for early brands.
Eg. Samosa Singh does INR3-4Lakhs monthly – without much channel partners

Business Model
Brands to share regular B2C margins (~25%) + 10-15% margins basis decision by
the category team

Tip: Only Recommended for impulse purchase F&B categories at a INR30-40 price point. Eg: YogaBar
Energy/Breakfast Bar – OK |  NOT for Large Muesli packs of 250gm. 
NOT for personal care categories.

BB Channels
BB Instant



Fruits and vegetables Foodgrains, oil & masala

Eggs, meat and fish

Kitchen, garden and pets

Cleaning and households
Beverages

Bakery Cakes and Dairy

Snacks and Branded Foods

Gourmet & World Food

Permissible L1 categories

Non-permissible L1 categories

Babycare

Beauty and Hygiene

600+ bb instant machines in Mumbai, NCR, Bangalore, Hyderabad
Per DC serves 100+ machines

BB Channels
BB Instant



Hyperlocal grocery delivery that offers 500+ SKUs for every morning
delivery between 5am-7am for orders placed before 10pm last night

Opportunity
bb daily contributes 7.5-10% of overall bb sales; high volume low revenue
contribution. Typical daily basket includes bread, coconut, milk, veggies
and fruits, edible oils, snack for kids

Business Model
Margins regular as the bb B2C platform but operates out of bb daily app

Sign-up for bb daily
Category team and Accelerate SPOC enable bb daily activation basis the
product volumes and capacity to serve new brands

Tip: Brands should focus on building scale 
on the bb B2C platform before expanding to 
bb daily. 

Brands can use bb daily platform for 
increased brand discovery but should not 
spend on additional marketing on the 
platform

BB Channels
BB daily



Fruits and vegetables

Foodgrains, oil & masala Eggs, meat and fish

Kitchen, garden and pets

Beverages

Frozen FoodsBakery Cakes and Dairy

Snacks and Branded Foods

Beauty & Hygiene

Gourmet & World Food

Babycare

BB Channels
BB daily



Institutional Partners

Hotel Partners

Restaurant Partners

Sales to the General Trade Retail and Kirana
stores, institutional chains  and HoReCa

Opportunity
bb B2B contributes 25% of overall bb sales and is typically an
opportunity for incumbent brands with over 2-3 years vintage on
the bb platform to increase their overall sales profile

Recommendation
Startup brands should not focus on B2B

BB Channels
BB B2B



Shop-in-shop Offer Page BannerHome Page Banner

Offer Page Banner 
inventory that can 
be purchased; not 
a part of the 
Accelerate 
Program (NOT 
RECOMMENDED) 

Home Page 
Banner inventory 
that can be 
purchased; 
expensive and 
not a part of the 
accelerate 
program; priced 
at 40 Lakhs for 4 
days! (NOT 
RECOMMENDED)

Shop by category 
grid where two 
SKUs of brands 
may be displayed 
at a cost; typically 
reserved for large 
FMCG brands 
(Category 
Leaders)

Other Visibility Elements
Navigating the Mobile Discovery Elements



Shop-in-shop Instant add-to-cartStore-front with with 3 SKUs

Can directly land 
on the checkout 
from the home 
page by clicking 
the basket

Store front with 3 
SKUs banner; 
presently not in use 
by any brand; not a 
part of accelerate 
program

Direct add-to-cart 
option available 
for the store front

Other Visibility Elements
Navigating the Mobile Discovery Elements



Product Listing Page Banners with no margin tileSquare Banner

Banners with no 
margin tiles present 
on home page; and 
not a part of the 
accelerate program

Store front with 3 
SKUs banner; 
presently not in use 
by any brand; not a 
part of accelerate 
program

Banners with 
margin tiles present 
on home page; and 
not a part of the 
accelerate program

Popular category 
grid to shop by 
brands which new 
startup brands can 
also bid for

Wireframe decided 
on monthly basis

Category teams 
reach out to brands 
for the available 
spots

Brand Store

Other Visibility Elements
Navigating the Mobile Discovery Elements



Category Page Banner*Home Page Shop-in-shop

*May later be a part of the accelerate program

Other Visibility Elements
Navigating the Mobile Discovery Elements



Website

BB App

BB AccelerateProTip: Expensive Inventory to NOT be used in the first 2 years of listing

BB Website
Eg: L1 Top Banner (web): under snacks & branded foods

Other Visibility Elements
Navigating the Mobile Discovery Elements

BB App
Eg: L1 Top Banner (app): under bakery, 

cakes and dairy

Row-long ad-element that is appears on top under the app and on the 
right as you hover over the L1 category on the web

Category L1 Top
Banner



Home Page Banners

Pro Tip: 80% of BB sales app-driven, de-prioritize desktop elements

Other Visibility Elements
Navigating the Desktop Discovery Elements (1/3)



Navigation Bar Vertical

L1 Categories L2 Categories L3 Categories

Navigation Bar Square

Other Visibility Elements
Navigating the Desktop Discovery Elements (2/3)



L2 Category Banner

Category Banners on desktop 
appear when a user clicks on a 
particular L1, L2 or L3 category 
to get the respective L1, L2 or 
L3 category banner

Other Visibility Elements
Navigating the Desktop Discovery Elements (3/3)



Search Term 
Banner

Row-long ad-element interlaced with search 
results that are thrown up with keyword/ 
brand searches
• Keywords: BB allows to tag upto 12 top keywords 

for a category 
• Rules: Broad targeting available – eg. a tea banner 

may be placed in a snacks search category

Search term banner for 
on-the-run bars with 
search for “Ghee”

Injection 
Banner

Row-long ad-element interlaced with store-
in-store listing displayed when browsing a 
category
• Injection banners may be used in more than one 

L2/ L3 category basis relevance

L1 Top 
Banner

Row-long ad-element that is appears on top 
under the app and on the right as you hover 
over the L1 category on the web

Web App BB 
Accelerate

Injection banner for Nescafe 
coffee under the Category > 
Beverages

L1 Top Banner (app): under 
bakery, cakes and dairy

L1 Top Banner (web): under 
snacks & branded foods

Summary of Ad-Types
Banners



Social Media 
Campaigns

Creatives run across social media channels 
such as FB and IG. 
• Micro-targeted ads using BB purchase 

and browsing (cookie) data.

Push 
Notifications

Creatives displayed over push notifications 
sent directly to the device lock screen/ 
notification center 

Web App BB 
Accelerate

Home Page 
Banner

Row-long ad-element that is available on the 
app/website home page

Note: BB Banner Best Practices guide.

Summary of Ad-Types
Banners, Social Media, PNs

https://drive.google.com/file/d/1FTFTgmdHwNonfQueEOaGKY_xfnImIa9p/view?usp=sharing


Parameters PNs, STBs, IBs Social Campaigns Home Page Banner

Image: Text Ratio >50% space to be occupied by images
>50% space to be occupied by images with 
some campaigns at 90% image shots

>50% space to be occupied by images with 
some campaigns at 90% image shots

Image Type
100% pack shot; can further be augmented 
thru usage shots

75% of the images are pack shots; with about 
50% including usage/end-products 

75% of the images are pack shots; with about 
50% including usage/end-products 

Comm. Obj.
Features and Benefits, Testimonials, Usage 
Occasions, Discounts

>60% focused on pdt. feature (ingredient story 
or differentiation) with <40% few others 
offering benefit/offer-based communication

>60% focused on pdt. feature (ingredient story 
or differentiation) with <40% few others 
offering benefit/offer-based communication

Offer type
Always include a number in the offer creative: 
could be amount-based or %age based

Coupon- or %age based (opt. BOGO); about 
40% of top-campaigns had no offers

Coupon- or %age based (opt. BOGO); about 
40% of top-campaigns had no offers

Offer timing Don’t mention offer period Don’t mention offer period Don’t mention offer period

Celebrity endorsement Not necessary Not necessary Not necessary 

Contest/ Sweepstakes Not necessary 
Only ~10% witnessed some contest in relation 
to pet-based foods

Only ~10% witnessed some contest in relation 
to pet-based foods

Others Festive/Bulk offers
Communication around social 
engagement/emotional connect such as 
Grandma’s recipe

Visibility Elements
Summary of Creative Variables



BB Web and App 
experience

BB platform 
search algorithm

BB platform for logged in versus logged out users displays different 
elements

• Eg. Sponsored products or personalized banners are not available for 
users browsing the platform without logging in

• Since logged out users have to sign in before product purchase and 
form a minor segment of the BB customers, startup brands may focus 
on the impact for logged in users

Whenever a logged-in user searches for any product on the 
platform, the product listing is in the order of:
f (top_selling_SKUs of_geography, last_purchased_SKU, etc)

• Top SKUs in Mumbai maybe different from Bangalore

• Top SKUs for a formerly transacting user changes to the last 
purchased product to ease platform usage

Uninfluenceable
elements

Certain elements of the BB platform cannot be influenced:

• ”Refine by” filters available in product listing pages

• Search prompts offered when attempting to search for a 
particular keyword  

Refine by: filters of the BB platform are 
basis sales and are algo-driven; they 
cannot be influenced

Additional BB platform
Additional Platform knowledge



Engage through sharing unique articles on the styling, make-up, 
wellness blog

Eg. MamaEarth could write on “monsoon protection for babies” and 
have banners on the right for free; similarly other accelerate brands 
may request BB to place their banners in relevant articles

Engage by sponsoring recipe competitions where users can share 
their recipes & directly add-to-cart for the same swiping below

Eg. Main Course in Cheese offers recipes submitted and options to 
shop ingredients

Additional Discoverability Options

bb Cookbook bb Lifestyle Blog



Thank You


